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[bookmark: _Toc218660194][bookmark: _Toc255977654][bookmark: _Toc320610750][bookmark: _Toc321943539]Welcome!
Good morning and thank you for attending this POLICE TECHNICAL course.

My name is Thomas M. Manson, founder of POLICE TECHNICAL, the company which is presenting this technical training course.    Today you will be an attendee in a course which POLICE TECHNICAL and your instructor have been preparing for many months, and, truthfully, have been preparing for many years.   

POLICE TECHNICAL has worked for several months to make your class today a reality.  Each year we receive training requests from agencies across the country, and every successful class is the culmination of 4-6 months of coordination, marketing, and logistics.  A May or June class likely began with a training request from the previous year.
Your instructor has also worked for many years preparing to teach this class.  In addition to several years of law enforcement experience, many dedicated to the subject of your class; he or she has completed a lengthy process with 

POLICE TECHNICAL to become one of our instructors.  This process involves a documented hiring process, a thorough background investigation, a detailed instructor and materials development process, and a continuing program of mentorship. 

POLICE TECHNICAL and our instructors work hard to provide superior quality training for law enforcement in computer applications, online investigations, and forensics.  I can tell you without hesitation, “Your course today will be one of the best you have ever had in this subject, and your instructor is one of the best in the field of law enforcement”. 
I know you’ll find this class valuable, but if ever want to talk with me about your experience, or if you would like to talk about bringing a POLICE TECHNICAL training course to your agency or department I would happily speak with you.

Enjoy your class, and thank you again for attending this POLICE TECHNICAL course.

Respectfully,

Thomas M. Manson
POLICE TECHNICAL
812-232-4200 | www.policetechnical.com | info@policetechnical.com 

[bookmark: _Toc321943540]Our History 
In 2004 POLICE TECHNICAL LLC was establish to further professionalize the law enforcement training process created by Thomas M. Manson. 

In 2007 POLICE TECHNICAL was recognized as a Sole Source Provider by federal law enforcement agencies, offering a level of training unavailable from any other source.  POLICE TECHNICAL incorporated in 2009 to provide a suitable structure to expand business operations.  

In 2010, POLICE TECHNICAL scheduled more than 50 national training courses (primarily PowerPoint® for Public Safety™).

In 2012, s new classes were developed and being taught by 6 additional instructors.


[bookmark: _Toc321943541]Goals of the Course
1. To review the concepts which make a successful presentation
2. To provide a basic understanding of PowerPoint® 
3. To provide the knowledge, skills, and materials to master PowerPoint® 
4. To provide a detailed analysis of custom animation
5. To provide the knowledge to capture objects for use in PowerPoint® 
6. To provide information about saving and presenting presentations
7. To facilitate communication among attendees and agencies
8. To improve training through better communication and technology
[bookmark: _Toc218660195][bookmark: _Toc255977655][bookmark: _Toc321943542]Course Overview


[bookmark: _Toc218660196][bookmark: _Toc255977656][bookmark: _Toc321943543]Three Big P’s
1. Presentations Skills



2. Preparation



3. Practice

[bookmark: _Toc218660197][bookmark: _Toc255977657][bookmark: _Toc321943544]Three Big Q’s
1. Who is my audience?



2. What do I want them to Know, Do or Believe?



3. What is the most effective way to accomplish my goal?

When is it too much?


[bookmark: _Toc218660198][bookmark: _Toc255977658][bookmark: _Toc321943545]Starting PowerPoint®
[bookmark: _Toc218660199][bookmark: _Toc255977659][bookmark: _Toc321943546]The First Slides
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[bookmark: _Toc218660200][bookmark: _Toc255977660][bookmark: _Toc321943547]Button, Ribbon and Tabs
[image: ]  [image: ]Normal
Slide Sorter

[image: ]
[image: ]Pressing this icon will expand the options available to the user.
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[image: ]Slide Show Tab
View Tab
Animation Tab
Review Tab
Design Tab
Insert Tab
Home Tab



[image: ]

[image: ][image: ]

[image: ]             [image: ]

[image: ]    Slide layouts may be changed from the Layout drop down menu.
Typing in the text box will allow the creation of “bulleted lists”, will removing the insert options box below.

These items may be added later from the Insert tab.
“Bulleted List” slides offer six different insert items:

Table
Charts
Smart Art Graphics
Insert Picture
Insert Clip Art
Insert Media
View Tab

[bookmark: _Toc218660201][bookmark: _Toc255977661][bookmark: _Toc321943548]Faster Development
[bookmark: _Toc218660202][bookmark: _Toc255977662][bookmark: _Toc321943549]Copy and Paste and Promote
[image: ][image: ]Open PowerPoint and Paste the copied text in the subtitle box.

Faster Development starts in Microsoft WORD with a simple outline.

Copy the outline with CTRL-C or right click and Copy.


[image: ]  [image: ]From the outline tab, place your cursor in front of the first word in the outline and promote it using Shift+Tab.

Repeat this process on the remaining main points.

Note:  Delete the first blank slide.


[image: ]Promote and Demote buttons are also found on the Home tab, in the Paragraph section.

Shift+Tab = Promote

Tab = Demote






[bookmark: _Toc218660203][bookmark: _Toc255977663][bookmark: _Toc321943550]Microsoft Word® and XML
[image: ]XML is a programming language which allows programs to interact more efficiently.

In WORD® create a simple outline.

Then apply headings from the Home tab, Styles section.

Heading 1 – will turn into Slide titles
Heading 2 – will turn into bullets
Heading 3 – will turn into sub points


[image: ]
[image: ]“Firearms In-Service” has been formatted with Heading 1.





[image: ][image: ]“Instructor and Importance of Training” has been formatted with Heading 2.


[image: ]This outline has been completely formatted with Headings.

Save the document as a 2007 WORD® document; with the .docx extension.


[image: ]                 [image: ]
[image: ]Once the document is saved as a WORD® 2007 or .docx file, close it. Next, open PowerPoint® and open the document using the Open file command.


[image: ]  [image: ]PowerPoint® typically tries to open its own file types exclusively.  Make sure “All Files” are selected to be shown. 






[image: ]Selected the appropriate WORD® file, and click Open.


[image: ]The Headings within the document will show in PowerPoint.  

Heading 1 creates a new slide its text as the title.

Heading 2 creates a bullet below the previous Heading 1.

A new Heading 1 creates a new slide.

Note:  Normal text, or unformatted text will not be imported into PowerPoint®.










[bookmark: _Toc218660204][bookmark: _Toc255977664][bookmark: _Toc321943551]Table of ContentsA Table of Contents can easily be added to a WORD® document with applied headings.

From the Insert Tab, on the Pages section, Page Breaks may be added.



[image: ][image: ]Table of Contents options are found on the References Tab, Table of Contents section


[image: ][image: ]A Table of Contents is created, in place of the cursor, once a style is selected.

[image: ][image: ]Right clicking a Table of Contents allows for the entire table to be updated or the page numbers only.  Page numbers are automatically figured regardless of whether or not the document has numbers on the actual pages.  Pressing F9 will also update the table.



[bookmark: _Toc218660205][bookmark: _Toc255977665][bookmark: _Toc321943552]Cover Page
[image: ][image: ]Cover Pages are found on the Insert Tab, Cover Page button.  Several styles are available; many more are available for download.




[bookmark: _Toc218660206][bookmark: _Toc255977666][bookmark: _Toc321943553]Using PowerPoint®
[bookmark: _Toc218660207][bookmark: _Toc255977667][bookmark: _Toc321943554]Insert
[image: ]A table can be inserted onto any slide using Insert tab.

Once the number of columns and rows are determined, the table can be formatted.

[bookmark: _Toc218660208][bookmark: _Toc255977668][bookmark: _Toc321943555]Table
[bookmark: _GoBack][image: ]                [image: ]   
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[bookmark: _Toc218660209][bookmark: _Toc255977669][bookmark: _Toc321943556]Picture
[image: ]A picture can be inserted to any slide using Insert tab.

Once the image is inserted, the Format Picture toolbar will appear.  

Several borders and coloring options are available.

Cropping is available on the far right of the toolbar.

[image: ][image: ]
The Set Transparent Color Option is found under the Recolor drop down.  This feature will allow the user to remove the background color from certain images.

[bookmark: _Toc218660210][bookmark: _Toc255977670][bookmark: _Toc321943557]Clip Art
[image: ]   [image: ]   [image: ]The Clip Art Gallery is keyword searchable and contains 100,000’s of royalty free, high quality images and pictures.


[image: ]   [image: ]
[image: ]Quality settings for images can be set by the user.  This can greatly reduce the size of PowerPoint® files.

[bookmark: _Toc218660211][bookmark: _Toc255977671][bookmark: _Toc321943558]Photo Album
[image: ]The Photo Album feature quickly inserts multiple images from a single directory (ie camera, folder, or other source).

Once a source is selected, all images can be chosen for insertion.

[image: ]  [image: ]
[image: ] Selected images are shown in a preview window and can be adjusted using rotation, contrast, and brightness.

Album Layout provides framing options – including the number of images per slide and borders.


 [image: ]   [image: ]


[bookmark: _Toc218660212][bookmark: _Toc255977672][bookmark: _Toc321943559]Shapes
[image: ]  [image: ]Simple shape changes (shade and border) can be affected using the pop-up menu.

Right clicking on a shape allows access to the Format Shape menu.
A variety of shapes can be added to any slide.

Shapes can be formatted by right clicking on a shape and selecting the option for Format Shape….

[image: ]	[image: ]Format Shape options

[image: ]	[image: ]
[image: ]	[image: ]Format Shape options

[image: ]	[image: ]

[image: ]	[image: ]Multiple shapes can be “grouped” to make a unique object.  

The new “object” can then be animated as a single object – such as the car example here.


[image: ]    [image: ]
Objects on the screen can be “selected” and made “invisible” based on selections here.
The Selection Pane is found at the bottom of the Arrange drop-down menu.

[bookmark: _Toc218660213][bookmark: _Toc255977673][bookmark: _Toc321943560]SmartArt
[image: ][image: ]

[image: ]	[image: ]Smart Art graphics allow data to be presented in thousands of different formats.

Once a graphic is created it can be immediately altered.


[image: ]

[image: ]

SmartArt Tools: Design and Format tabs



[bookmark: _Toc218660214][bookmark: _Toc255977674][bookmark: _Toc321943561]Chart
[image: ]Charts, using Excel®, can be inserted onto any slide.

Users can select their chart style at the beginning of the process and adjust or change it later.


  [image: ]    [image: ]

[image: ]

[image: ]
Chart Tools: Layout and Format tabs

[bookmark: _Toc218660215][bookmark: _Toc255977675][bookmark: _Toc321943562]Design Themes
[image: ]
[image: ]	[image: ]Design Themes are available from the Design tab.

A variety of stock Design Themes are available from the basic program, additional themes are downloadable.

Colors and backgrounds are among the changes users may select to alter Design Themes.

Users may also create and save their own unique Design Themes.


[image: ]Background style changes are more subtle than changing an entire Design Theme.

[bookmark: _Toc218660216][bookmark: _Toc255977676][bookmark: _Toc321943563]Saving and Publish
[bookmark: _Toc218660217][bookmark: _Toc255977677][bookmark: _Toc321943564]Presentations
[image: ] [image: ]A presentation may be saved using the Microsoft button in the upper left hand corner, then Save As…

The first option is a PowerPoint Presentation.

Opening this file will open the “development” mode of PowerPoint®.  All slides will be shown in addition to the standard toolbars of the program.


[image: ]
[bookmark: _Toc218660218][bookmark: _Toc255977678][bookmark: _Toc321943565]Shows
[image: ]A presentation may be saved using the Microsoft button in the upper left hand corner, then Save As…

The second option is a PowerPoint Show.

Opening this file will immediately open the first slide of the presentation full screen.  The “Development mode” of PowerPoint® will not be shown. 

[image: ][image: ]
[bookmark: _Toc218660219][bookmark: _Toc255977679][bookmark: _Toc321943566]
Other Options
[image: ] A presentation may be saved using the Microsoft button in the upper left hand corner, then Save As…

The third option is a PowerPoint 97-2003 Presentation.

Saving a PowerPoint® 2007 presentation in this manner will “flatten” or degrade all graphics created using 2007 tools.  Changes will be indicated by the Compatibility Checker.

Note: Users should retain a PowerPoint® 2007 copy for future editing of any presentation downgraded into a PowerPoint® 97-2003 file.


[image: ]
[image: ] [image: ]
[image: ]Numerous other file extensions are supported for saving a presentation including: Templates, Office Themes, XML presentations, and several graphics files.




[bookmark: _Toc218660220][bookmark: _Toc255977680]

[bookmark: _Toc321943567][bookmark: _Toc218660221][bookmark: _Toc255977681]Publish
Package for CD
[image: ]Package for CD creates a folder which includes:
1. The original presentation 
2. All linked files (including videos, and other presentations)
3. The PowerPoint® viewer, which allows the presentation to be run without a full installation of PowerPoint®.



[image: ]After naming the “CD” the presentation can be:
1. Copied to a folder or 
2. Copied to a CD.





[image: ]Copy to Folder options



[image: ]		[image: ]

[image: ]Files included the Package to CD feature.

[bookmark: _Toc218660222][bookmark: _Toc255977682][bookmark: _Toc321943568]
Handouts in Microsoft Word®
[image: ]	[image: ]
[image: ]PowerPoint® can be “sent” back to WORD® using the “Create Handouts…” feature.

Options include:
Speakers notes next to slides, and 
Outline only

[image: ]
[bookmark: _Toc255977683][bookmark: _Toc321943569][bookmark: _Toc218660223]
SecurityPowerPoint® can be “sent” back to WORD® using the “Create Handouts…” feature.

Options include:
Speakers notes next to slides, and 
Outline only

[image: ]
Security can be enabled from the Save As… window by selecting Tools, General Options….

Two level of security include:
Password to open
Password to Modify

Personal information (such as name and “company” information of the developer can be removed upon saving.

[image: ]


[bookmark: _Toc218660224][bookmark: _Toc255977684][bookmark: _Toc321943570]Printing Presentations
[image: ]

[image: ]


[bookmark: _Toc218660225][bookmark: _Toc255977685][bookmark: _Toc321943571]Hyperlinking
[bookmark: _Toc218660226][bookmark: _Toc255977686][bookmark: _Toc321943572]Rules of Hyperlinking
1. PowerPoint® “sees” nearly everything on a slide as an “object”
a. This includes: Text boxes, pictures, clip art, et cetera.

2. Any object can have an action setting or hyperlinks applied to it.
 
3. To apply an action setting the object must be selected (e.g. have grab bars appearing)

4. Have a legitimate reason for using action settings

5. Make action setting simple
[bookmark: _Toc218660227][bookmark: _Toc255977687][bookmark: _Toc321943573]Action Buttons
[image: ][image: ][image: ]




[bookmark: _Toc218660228][bookmark: _Toc255977688][bookmark: _Toc321943574]Action Settings
[image: ]
[image: ]		[image: ]

[image: ][image: ]
[image: ][image: ] 

[image: ][image: ]
[image: ]
[image: ][image: ][image: ]
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[bookmark: _Toc218660229][bookmark: _Toc255977689][bookmark: _Toc321943575]Hyperlinks
[image: ][image: ]
[image: ]	[image: ]


[bookmark: _Toc218660230]

[bookmark: _Toc255977690][bookmark: _Toc321943576]Creating a Splash Screen®
1. Create your presentations
a. Gather them in one location (not required, but helpful)
2. Create another presentation with a single slide 
a. This will become your Splash Screen®
3. Place a variety of shapes on the slide to serve as anchors
a. Use shapes (with text) instead of Text Boxes
b. Include additional shapes for future expansion
4. Apply action settings to each shape
a. Hyperlink to “Other PowerPoint® Presentation…”
5. Modify shape color and text
a. Two lines of at least ten characters are a good guide
6. Save Splash Screen as a PowerPoint® show file (.ppsx)
[image: ]
1. Clicking the Splash Screen icon (XXXXX.ppsx) will activate the slide show.
2. Clicking on a “hyperlinked” shape will cause that presentation to open.
3. A presentation will close after its last slide (or with the ESC key) returning to the Splash Screen®
4. Use of the ALT+TAB key will facilitate moving between presentations
5. The Splash Screen® will close with the ESC key returning the user to the desktop.


[bookmark: _Toc218660231][bookmark: _Toc255977691][bookmark: _Toc321943577]Creating a Timeline
A different type of Splash Screen® the Timeline is a self-contained presentation that links to itself.  In the example below the entire presentation is merely 5 slides long.  
1. Create slides representing each moment of time
a. This process is greatly aided with Microsoft Word©
b. Timelines can be of any period.  Fractions of seconds to years.
2. On any slide use lines or shapes to represent the timeline
3. Place a variety of shapes near the timeline to serve as anchors, or use the timeline itself
a. One shape for each moment in time
b. Callout boxes work nicely, Line Callout 2
c. Text boxes can be added to enhance understanding
d. Terminators at opposite ends of the timeline help define the scale
4. Apply action settings to each shape
a. Hyperlink to “Slide…”
5. Copy “hyperlinked” timeline to each slide
6. Modify shape color of timeline anchor on its corresponding slide
a. This helps the audience understand which moment on the timeline is being discussed
7. A “Home” text box, linked to the first slide, placed on the Master slide, will assist with navigation
8. Save file as a PowerPoint® show file (.ppsx)
[image: ]
1. Clicking the Splash Screen icon (XXXXX.ppsx) will activate the slide show, i.e. the timeline.
2. Clicking on a “hyperlinked” shape will cause that slide to open.
3. A presentation will close after its last slide or at any time with the ESC key



[bookmark: _Toc218660232][bookmark: _Toc255977692][bookmark: _Toc321943578]Games
[image: ]
[image: ]
[image: ]

[bookmark: _Toc218660233][bookmark: _Toc255977693][bookmark: _Toc321943579]Promotional Package

[image: ]
[image: ]	
[image: ]
[bookmark: _Toc218660234][bookmark: _Toc255977694][bookmark: _Toc321943580]
Animation
[bookmark: _Toc218660235][bookmark: _Toc255977695][bookmark: _Toc321943581]Transitions
[image: ]
[bookmark: _Toc218660236][bookmark: _Toc255977696][bookmark: _Toc321943582]Animation through Transition
[image: ]		[image: ]		[image: ]
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[bookmark: _Toc218660237][bookmark: _Toc255977697][bookmark: _Toc321943583]Stacking Order
[image: ] 	[image: ]
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[bookmark: _Toc218660238][bookmark: _Toc255977698][bookmark: _Toc321943584]
Selection and Visibility Tab
[image: ] 	[image: ]
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[bookmark: _Toc218660239][bookmark: _Toc255977699][bookmark: _Toc321943585]Custom Animation
[bookmark: _Toc218660240][bookmark: _Toc255977700][bookmark: _Toc321943586]Entrance
[image: ]
[image: ]     [image: ]
[bookmark: _Toc218660241][bookmark: _Toc255977701][bookmark: _Toc321943587]
Emphasis

[image: ]

[image: ]     [image: ]


[bookmark: _Toc218660242][bookmark: _Toc255977702][bookmark: _Toc321943588]Exit

[image: ]

[image: ]   [image: ]


[bookmark: _Toc218660243][bookmark: _Toc255977703][bookmark: _Toc321943589]Motion Paths
[image: ]		[image: ]

[image: ]		[image: ]
[bookmark: _Toc218660244][bookmark: _Toc255977704][bookmark: _Toc321943590]Effects and Timing

[image: ][image: ]

[image: ]  [image: ]



[bookmark: _Toc218660245][bookmark: _Toc255977705][bookmark: _Toc321943591]Advanced Timeline

[image: ][image: ]


[bookmark: _Toc218660246][bookmark: _Toc255977706][bookmark: _Toc321943592]Animating Text

[image: ]
[image: ]



[bookmark: _Toc218660247][bookmark: _Toc255977707][bookmark: _Toc321943593]Diagramming Process

“Good, Fast, Cheap…Pick Two.” Guiding Principle of Custom Development

To create custom animations in PowerPoint® you need four things in place:
1. A clear understanding of the process you wish to animate
a. If you can verbally describe it can likely be animated in PowerPoint®
2. A clear understanding of the PowerPoint® custom animation principles
a. Understanding what PowerPoint® can and cannot do defines the project
3. Time
a. The importance of the project and its frequency of use should determine how much time is devoted to a custom animation
b. If an animation will be used in the academy for the next 5 years it warrant spending 24 hours to perfect it; likewise a onetime use for an important court case.
4. Patience
a. Animation will try the patience of most first time developers

The following three steps make developing animations in PowerPoint® more effective and time efficient:
1. Talk out the process
a. With someone equally knowledgeable on the topic
b. Talk it out, out loud
2. Sketch out the process
a. Using paper and pen
b. Draw out the process as you understand it
i. Story board
ii. Single image
c. Use stick figures and simple shapes
d. Label major components
e. Note: If you cannot draw the animation, you should question if custom animation is the best option for the project.  Video or pictures may be more effectively and quicker.
3. Begin development in PowerPoint®
a. Resist the urge to skip steps 1 and 2.
b. The sketch is actually an outline which if created and used will
i. Greatly speed development
ii. Increase accuracy of the final project
1. 

[bookmark: _Toc218660248][bookmark: _Toc255977708][bookmark: _Toc321943594]Animation Case Study – Vehicle

[image: ]     [image: ]
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[bookmark: _Toc218660249][bookmark: _Toc255977709][bookmark: _Toc321943595]Audio
[bookmark: _Toc218660250][bookmark: _Toc255977710][bookmark: _Toc321943596]Adding a Soundtrack
[image: ]
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[image: ]
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[image: ][image: ]
[image: ]
[bookmark: _Toc218660251][bookmark: _Toc255977711][bookmark: _Toc321943597]
Record Narration
[image: ]
[image: ]
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[bookmark: _Toc218660252][bookmark: _Toc255977712][bookmark: _Toc321943598]911 Recording and Text
The process for combining an audio tape with a transcript is 
1. Obtain a digital copy of the recording (.wav, .mp3)
2. Obtain a digital copy of the transcript of the recording. (Microsoft Word®)
3. Create a presentation from the transcript with no more than a few paragraphs per slides.
4. Insert the audio file onto the first slide
a. Select to play automatically
5. Make sound play for entire presentation 
a. Either from Ribbon  - Options Tab - “Play across slides”
b. Custom Animation – Effects - Stop playing after XX of slides
6. Rehearse Timings from the Slide Show tab
a. Advance to the next as the transcript is “read” using the space bar
7. F5 to test; save as ppsx.
[image: ]
[image: ][image: ]
[image: ]	[image: ]
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[bookmark: _Toc218660253][bookmark: _Toc255977713][bookmark: _Toc321943599]Video
[image: ]	[image: ]
[image: ]
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[bookmark: _Toc218660254][bookmark: _Toc255977714][bookmark: _Toc321943600]
From the Internet
     

[image: ]     

          
     
[bookmark: _Toc255977715]

[bookmark: _Toc321943601]Camtasia
[image: ]
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[bookmark: _Toc218660255][bookmark: _Toc255977716][bookmark: _Toc321943602]Other Options
Firefox extensions



Third Party Programs


[bookmark: _Toc218660256][bookmark: _Toc255977717][bookmark: _Toc321943603][image: ]Keyboard Shortcuts
CTRL + Z	Undo
CTRL + Y	Redo
CTRL + B	Bold On/Off
CTRL + X	Cut
CTRL + C	Copy
CTRL + V	Paste
CTRL + M	New Slide
CTRL + N	New Presentation
CTRL + O	Open dialog box
CTRL + S	Save
CTRL + D	Duplicate
CTRL + R	Right justify text
CTRL + L	Left justify text
CTRL + E	Center text
CTRL + A	Select all
CTRL + P	Print dialog box















PowerPoint® 2007 Only
ALT +	(another letter)	Opens the entire ribbon for access
[image: ]		
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[image: ]
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